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Navigator Overview

Navigator is an add-on application to X_TRADER® Pro that allows a trader to display bids and offers for two contracts side-by-side.  It will then allow them to submit orders on either of the two contracts.  If desired, Navigator can also route orders to the best market based on rules set up by the trader during setup.  Navigator allows a trader to submit Market, Limit, Stop Limit, Stop Market, and OCO orders, where the stop orders can trail with the market.  The OCO orders can be on either one contract or between the two contracts.  In addition, Virtual Orders, which are held on the client machine until triggered, can be placed
Installation

1. Verify that both X_TRADER and the X_TRADER API are installed.  Verify that X_TRADER Pro is enabled.

2. Double-click on the installation file (i.e. Navigator_Install.exe).  This opens the Navigator installation wizard.

3. Click the Next button through all of the screens of the installation wizard, changing the default User Information and Destination Folder if desired. 

4. The application will be installed.  The last screen will display a message that Navigator was successfully installed. 

5. Click the Finish button.  A Navigator shortcut icon will be added to the Desktop.  The computer does not need to be rebooted

Product Features

Navigator Basics

1. Navigator can be launched by double-clicking the Navigator desktop icon after X_TRADER Pro is started.  Users with X_TRADER 6.13 or higher can launch Navigator from the Plug-ins button off of the X_TRADER Control Panel. 
2. Upon launching, Navigator will automatically load up the last saved configuration.  If there is no previously saved configuration, a label appears in the center of the application that states “Drag & Drop Contracts”.  This application will not take any action until contracts are dropped into the application from X_TRADER’s Market Grid window. 

3. A contract is the combination of a Gateway, a Product, and the Expiration of the contract.  Ex. CME-A WS Aug06.  Navigator supports Futures contracts, exchange traded Spreads, and Options.

4. The user can run numerous instances of Navigator on their computer, but a single application will allow access to unlimited contracts.  

5. Closing Navigator will not delete any resting orders that were entered through Navigator, but will decouple any OCO orders leaving a disconnected stop and limit order.  The user can cancel these orders prior to closing the application.  In addition, any Virtual orders will be saved as locally held orders if Navigator is closed.

Navigator – Main Window
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          Figure 1.  Navigator Main Window
1. The Navigator window contains six columns:

· Name:

Alias for contract pair 

· Contract #1:
Name of the first contract

· Contract #2:
Name of the second contract 

· Setup:

Launches the Setup window for the pair

· Depth:

Launches the Depth window for the pair

· Grid:

Launches the Grid window

2. Multiple futures contracts can be dropped from X_TRADER’s Market Grid window to Navigator.  Newly dropped contracts will be added as a row item to the end of the list. 

3. Navigator consists of pairs of related contracts (i.e. CME WS Aug06 & ICE WTI 6-Aug).  Navigator’s main window will automatically resize to display up to 10 different contract pairs.  If more than 10 contract pairs are added to the list a scroll bar will appear and the list will still contain all contracts that the user will be allowed to access via Navigator.

4. The user can populate the Contract #1 fields by dropping contracts anywhere on the application.  To populate Contract #2 fields, the user must first highlight a row.  Then they must drop a contract or multiple contracts into the highlighted Contract #2 cell. The Contract #2 field is optional.

5. If multiple contracts have been populated into the Contract #1 field, the user can drop multiple contracts into the Contract #2 field by first clicking on a Contract #2 field to highlight it in white and then dropping multiple contracts into the highlighted cell.  “Initializing Instrument” may display in the Contract columns while the contract is being added into Navigator.  

6. Multiple configuration files can be saved by choosing the File->Save As menu item.  The current contract layout and settings are saved with the workspace.  Choosing File->Open will allow the user to open a previously saved configuration file.  For simplicity, the last open configuration will be opened upon launching.

7. The Navigator main window is the main control panel that is used for managing and launching multiple contract pairs.  Closing this main window closes the whole application and all windows associated with it.

8. The Fill Count will be displayed at the bottom of the screen.  The Fill Count represents the number of fills for all exchanges that X_TRADER is currently logged into.  This value will continue to update as more fills come in. 

Navigator – Menu Options

1. Within the File menu there are five menu items: 

	· Open:
	Opens an existing Navigator workspace.

	· Save:
	Saves the workspace.  The default name is Navigator.nws.

	· Save As:
	Saves the workspace with the current/new name.

	· Clear:
	Clears all of the contracts out of the current workspace.

	· Exit:
	Exits the Navigator application.


2. Within the Preferences menu there are ten menu items: 

	· Default Settings:
	Opens the Default Settings Setup window to specify default values and routing rules for new contracts added to the workspace.

	· Exchange Unavailable Action:
	Action when an Exchange goes down.  There are three possible values:

· Route To Available – Route all orders to the exchange that is available.
· Stop All Orders – Stop all orders from being submitted.
· Stop Its Own Orders – Stop the orders for the exchange that is down and send the orders in for the available exchange.

	· Global Re-centering:
	Enable/Disable re-centering of all Depth windows when any window is re-centered.

	· Detached Quantity Pad
	Set the position where the Quantity Pad will display.  By default it is accessible by clicking on the Quantity field in the top left corner.  If checked it displays along the left side of the Navigator – Depth window.

	· Quantity Pad Tracks Market
	This Preference is enabled only if Detached Quantity Pad is selected.  If checked the Quantity Pad position along the Depth window will move vertically up/down with the market trends.

	· Include Implieds:
	Include/Exclude the exchange supplied implied values with the market depth.

	· Show LTQ:
	Show/Hide the Last Traded Quantity Pane

	· Confirmation Messages
	Select if order confirmation windows should be displayed when placing orders on an individual contract through Navigator.  Confirmation messages will not be displayed when using the Route to Best Functionality with more than 1 contract.  Select Add Order Confirmation, Delete Order Confirmation, and/or Change Order Confirmation if a confirmation window should be displayed before adding, deleting, and/or changing an order.  Select Cancel Button Default if the Cancel button should default on the confirmation window.  Not selecting it means the Confirm button will default.     

	· Order Pane:
	Select either: No Delay, ½ Sec. Delay, 1 Sec. Delay, Center Click Active, or Hide Order Pane.  See item #107 of the Order Pane section.

	· Order Handling Mode
	Select either: LTP Mode or Inside Market Mode.  This mode is used to determine whether the Last Traded Price or Last Traded Bid/Ask is used for trailing stops and to trigger a Virtual Order.

	· Iceberg Price Mode
	Select either: Static or Last Fill. When Last Fill is selected, each round of iceberg orders will be submitted at the fill price of the previous round. When Static is selected, each round of iceberg orders will be submitted at the original order price.

	· Iceberg Disclosure Mode
	Select either: Quantity or Percent. This will dictate how Navigator calculates the order quantity for each round. If Quantity is selected, a “QD” text box will show up. If Percent is selected, a “PD” text box will show up.


3.  Within the Help menu there are two menu items:

	· Contents:
	Displays the Navigator Read Me Document.

	· About Navigator™:
	Navigator version information.


Navigator – Setup Window
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      Figure 2.  Navigator Setup – Contract Info Window

Contract Info
1. Navigator contains a default Setup window, accessible from the Preferences menu, which can be used to specify default values for new contracts added to the workspace.  In addition, there is a Setup window associated with each contract group.  Properties specified for one contract group can be different than those of another group.  

2. The Setup window for a contract group can be launched by either clicking the Setup button on Navigator’s Main window, or by right-clicking and choosing Setup from the popup menu on Navigator’s Grid and/or Navigator’s Depth window.

3. The Group Name field defaults to Contract #1’s name when the first contract is dropped into Navigator.  When the second contract is dropped into the pair, the Name field populates as “Group #1” with the number corresponding to the row number on the Navigator Main Window.  This contract, which appears below Contract #1 in the Contract Information grid, will be referred to as Contract #2.  The user can edit the Group Name field with a more applicable alias from within the Setup page.  
4. Contract #1 & Contract #2 have “Contract” and “Short Name” fields.  These fields are editable.  The Short Name field values are used for the column headers on the Depth Grid.  Dropping in the appropriate contract onto the Navigator Main window populates these fields.

5. The Maximum Quantity field must be a numeric value from 0 to 1,000,000,000.  This value must be greater than 0 for orders to be entered in either the Grid or the Depth windows.

6. The Default Quantity is the order quantity that will be entered on launch and after every order is submitted.  This value must be less than or equal to the Maximum Quantity.

7. The Right-Click Quantity is the order quantity that will be entered when the user right-clicks on a contract or combined column.  This value must be less than or equal to the Maximum Quantity and can only be set and active if the corresponding checkbox is selected.

8. In addition to being able to type into the Right-Click Quantity field, the user can also link the value to a spreadsheet cell through a DDE (Dynamic Data Exchange) link.  To establish a link, copy the appropriate cell from the spreadsheet, right-click in the Right-Click Quantity field and select Paste Link from the popup menu.  The appropriate value will be displayed and the field will turn yellow to indicate that the field is a linked value.  The Right-Click Quantity will dynamically update as the spreadsheet value changes.

9. In order to remove the link, right-click in the field and select Remove Link from the popup menu.  The field will turn white and the quantity will return to 0.  The quantity will no longer dynamically update.  In order to reestablish the link, right-click in the field and select Re-Link from the popup menu. 

10. If the Right-Click Quantity value is disabled, the Right-Click Qty checkbox has not been checked.  If the field is white, a non-linked quantity has been entered.  If it is yellow, a link has been established.  If the field is orange, the value in the spreadsheet has exceeded the specified Maximum Quantity.  The Right-Click Quantity will be the Max Qty until the spreadsheet value goes below the Max Qty threshold.  If the field is gray, the link has been de-established or the value is invalid.  For example, this could occur if the spreadsheet closed or a word was entered instead of a number.  Right-click the Qty field and select Remove Link or Re-Link from the popup menu to make the quantity field editable or linkable again. 
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              Figure 3.  Navigator Setup – Layout Window
1. The Price Layout section allows the user to update the price display by adjusting the price ratios and offsets between contracts.  
2. View prices as Contract: Allows the user to select the contract whose price format Navigator should use to display its prices in. 

3. Show every Price level: Adjusts the price display in Navigator to display every tick of both contracts.  The price is adjusted around the price level of the contract with the least common denominator of its price increments.  If one contract ticks in .01 and one contract ticks in .025 the price display will show .01, .02, .025, .03, .04, .05, .06, .07, .075, .08, etc. and center around the .01 price level.  If the two contracts ticked in .5 and .005 the price display will center around the .005 contract’s price level.  The price offset functionality will be disabled when displaying prices in this format.
4. Number of Decimals: Used to control the number of decimals the prices are displayed in when the Price Layout is set to Show every price level.

5. Update the Price Multiplier cell(s) to help line up the two contract’s prices in Navigator.  For example, if Contract #1’s price is 7405 and Contract #2’s price is 74050, then either Contract #1’s multiplier should be 10 or Contract #2’s should be .1.  Then the prices will display side-by-side in the Depth Window.
6. The Price Offset is the value that should be added to one contract to display its prices side-by-side with the other contract.  For example, if Contract #1’s price is 74050 and Contract #2’s price is 74550, then either Contract #1 could be given a price offset of 500 (74050 + 500 = 74550) to align it with Contract #2, or Contract #2 could be given a price offset of -500 (74550 – 500 = 74050) to align it with Contract #1.
7. If the two contracts also have been adjusted for a price multiplier, the offset will be calculated after the multiplier is applied.  For example, if Contract #1’s price is 7405 and Contract #2’s price is 74550, Contract #1 could be given a Price Multiplier of 10, then Contract #1 could be given an offset of 500 [(7405 * 10) + 500 = 74550], or Contract #2 could  be given an offset of -500 [74550 - 500 = (7405 * 10)].  Then the prices will display side-by-side in the Depth Window.
8. The Quantity Layout allows the user to enter a quantity multiplier to properly normalize the different trading units.
9. The Quantity Multiplier fields allow the user to adjust the quantity relationship between the two contracts.  For example, if Contract #1 trades at a unit that is 2 times the trading unit of the Contract #2, 1 unit of Contract #1 is equal to 2 units of Contract #2.  To trade in relative size to Contract #1, set the quantity multiplier of Contract #2 equal to 2.  To trade in relative size to Contract #2, set the quantity multiplier of Contract #1 to .5.  
10. If a Quantity Multiplier is used Navigator will display all contracts in the relative size of the whole contract. For the example above, the Navigator Window will display the size at each level for Contract #2 in one half the size of Contract #1. This allows the user to accurately view how many “whole” contracts there are available at each level.  If an order for 10 lots was placed and entered on Contract #2, Navigator will send this order with a size of 20 lots.  If the Quantity Multiplier is updated, consider updating the Number of Decimals to a value greater than 0 to accurately display the amount of available “whole” contracts at each level.
11. Number of Decimals: Used to control the number of decimals the quantity of an order should display in.  For example, if a user places an order to buy 10 lots the order would display as a 10.00 lot order if the Number of Decimal Places was set to 2.  If the Number of Decimal Places was set to 0 the order would display as 10.  If an order was routed to Contract #1 Navigator would work 30 lots in the market if the Quantity Multiplier was set between Contract #1 and Contract #2 at 3:1.  If this working order was then changed to 29 lots for Contract #1 this would display in Navigator as either a 9.67 lot order if the Number of Decimal Places was set to 2, or as a 10 lot order if the Number of Decimal Places was set to 0.
12. Clicking the Apply button updates the Navigator properties and display window with the new setup values without closing the setup window.  Clicking the Ok button saves the properties, and then closes the Setup window.  Clicking the Cancel button closes the Setup window without saving.
Routing Info
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      Figure 4.  Navigator Setup – Routing Info Window
1. Navigator allows a user to specify during setup which values are most important for determining which contract of the pair should be chosen when submitting orders. 

2. There are two different sets of rules, “Lifting” and “Joining”.  

3. “Lifting” occurs when a Buy order is entered at a price where a resting Sell order exists, or when a Sell order is entered at a price where a resting Buy order exists.  
4. “Joining” occurs when an order is entered and it is not “Lifting”.  This happens when a Buy is entered at a price where either resting Buy orders exist, or at a price below both contracts lowest Selling prices.  This also happens when a Sell is entered at a price where either resting Sell orders exist, or at a price above both contracts highest Buying prices. 

5. If either a Buy or Sell is entered at a price where resting Buys exists in one contract and resting Sells exists in the other contract, the “Lifting” logic prevails.  This will only use the “Lifting” logic, and will not use the “Lifting” logic for the available quantity and the “Joining” logic for the remaining desired quantity.

6. If the percentages are selected and the calculations dictate that one contract should be split between Contract #1 and Contract #2, if all percentages and qty’s are equal Contract #1 will always get the left over amount. Otherwise Navigator will allocate based on partial majority allocated or overall percentage allocated to one contract vs. the other.  

· Ex. Want 12 lot, 70% in Contract #1 and 30% in Contract #2 will desire 8.4 in Contract #1 and 3.6 in Contract #2.  This will result in 8 for Contract #1 and 4 in Contract #2, since Contract #2 had a higher percentage of the left over qty.
· Ex. Want 10 log, 75% in Contract #2 and 25% in Contract #1 will desire 7.5 in Contract #2 and 2.5 in Contract #1. This will result in 8 for Contract #2 and 2 in Contract #1, since the tie goes to Contract #2 because it’s higher percentage indicates a preference for it.

Joining

1. Always – This option will always break down the orders based on the supplied percentages.  See the examples section for an example of this.

Lifting/Hitting

1. Optimize (Flatten Position First) – By default this option is chosen allocating 100% to Contract #1 and 0% to Contract #2.  This option will always look first to buy at the contract with the best price.  If there are enough resting orders at both contracts, it will then look to flatten any open positions.  Once both contracts cannot be flattened any more the default percentages are used to determine how the breakdown will occur.  If one contract is Long 100, and the other is Long 5, when a Buy order is entered, the net position will have no effect on the decision process.  See the examples section for an example of this.

2. Optimize (Ignore Position) – This option will always look first to buy at the contract with the best price.  If there are enough resting orders in both contracts, it will then look to the default percentages to determine how the breakdown will occur.  See the examples section for an example of this.

3. Constant percentages – This option will always break down the orders based on the supplied percentages.  This will ignore resting available orders and will disregard the trader’s current position in each contract.  See the examples section for an example of this.
Navigator – Depth Window (View All)
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Figure 5.  Navigator Depth window (View All)

1. The Depth window will open with the Alias Name as the label of the window.  To save on space, an algorithm is used to concatenate the two contract names so that if they are different products on different exchanges, then only the product name will be displayed.  If it is the same contract with different expirations, then the expirations will be displayed.

2. The Depth window defaults to displaying in the “View All” format.  This means the contract columns and the combined columns are displayed.  The user can choose a different style by right clicking on the depth window and selecting a different display style.  The available styles are: “View All”, “Combined View” and “Split View”.

3. Contract #1 is closest to the price.  Contract #2 is on the outside.  To switch this order, the user must switch in which order they setup the pair in Navigator™.

4. The Price column will tick in the more granular tick price as to not lose any potential orders.

5. The Depth window default display also separates the Working Buy and Working Sell orders.  The user can choose a different display format by right-clicking on the depth window and selecting one of the following options: “Right Justify Price”, “Split Buy / Sell Orders” and “Hide Status Bar”.

6. Re-centering the grid can be performed by clicking the middle mouse button, double-clicking the price column, or by pressing the space bar.  Clicking the down or the up arrow buttons will scroll the window by one whole pane.  After re-centering, a dark black line separates the top half from the bottom of the grid.

7. The font size for the Depth window can be increased or decreased by pressing the “Shift + Left Arrow” or “Shift + Right Arrow” key combination, respectively.  Then the font size of the Order Pane window and the Quantity Pad will also re-size accordingly.

8. The yellow bar in the price column denotes the High of the day amongst both contracts.  The red bar in the price column denotes the Low of the day amongst both contracts.  All prices in-between these two bars are a darker gray showing that this is where trading has occurred.  Outside of these two bars are lighter gray. 

9. The Last Traded Price of either of the contracts will be displayed in the Price column by highlighting the cell.  The background will be green if the price went up.  It will be red if the price went down, and white if it remained the same.

10. <Default> is the default customer profile name.  There are two <Default> fields, the first one (on the left) corresponds to Contract #1 and the second (on the right) corresponds to Contract #2.  Clicking on the field will display a list from which a single customer profile can be chosen.  Once selected, all orders for that contract will be submitted using this customer profile.  

11. The combined bid quantity in blue will sum the quantity of Contract #1 and Contract #2 at each price and display the total.  The combined ask quantity in red will sum the quantity of Contract #1 and Contract #2 at each price and display the total. 

12. Each column can be made wider by grabbing the vertical bar on the right side of the header row of each column and dragging it to the appropriate width.  To minimize a column, simply slide the handle all the way to the left.  To redisplay hidden columns, right-click on the depth window and choose the appropriate display.

13. Dragging the height of the depth window automatically re-centers the grid and will dynamically add or remove rows.  The maximum number of rows is limited by the size of the screen.  There is no minimum number of rows.  

14. The top left cell of the Depth window is the Default Quantity.  After each order this value will be replaced with the default quantity selected from the Setup window.  When the Depth window is active, typing a number anywhere will add to the value.  Right-clicking on this quantity field will reset the value with the default value. 

15. Directly beneath the Default Quantity is the Right-Click Quantity.  This value can be edited directly on the Depth window or by opening the Setup window.  If the Right-Click Quantity is linked, the link can also be updated directly on the Depth window.     

Quantity Pad
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   Figure 6.  Navigator Quantity Pad

1. If Detached Quantity Pad is not selected from the Preference menu, when the user clicks on the quantity cell, the quantity pad displays as in Figure 6 and 7. There are two tabs within the quantity pad: Quantity Pad and Order Mode.  The last used mode is remembered and displayed when the quantity pad is accessed.  Moving off the quantity pad or clicking the “Close” button will close the quantity pad.  See Figures 8 and 9 for the detached version of the Quantity Pad.  

2. The value that is displayed in the upper left hand of the quantity pad will be the quantity of the order that will be submitted next unless it is changed.  

3. Right-clicking on the quantity, will re-seed it with the default quantity.  Clicking the “Set as Default” button will save the current value as the new default quantity.

4. Clicking on the Clear button will reset the quantity to 0.
5. The numbers on the Quantity pad can be overwritten by right-clicking on a number, entering the desired number and hitting Enter.  If a number was in the thousands, it will put a decimal between the thousand values and the non-thousand values and add a “K”.  Ex. 2,500 = 2.5K.   The same applies to millions except with an “M”.  
6. The value of the quantity cannot exceed the maximum value specified in the Setup window for each pair.  If a number does exceed this value it will stop at that maximum number.  (Ex. Max Quantity = 25 and user adds 20 and then adds 30, then it will display 25).

7. Add – Selecting this option will add the quantity to the button that has been clicked.  It will add the values “1” & “2” & “10” = 13.

8. Calc – Selecting this option treats the quantity pad like a calculator within Microsoft Windows.  It will concatenate the string “1” & “2” & “10” = 1210.

9. Replace – Selecting this option replaces the existing quantity with the newly selected button.  The result of pressing “1” & “2” & “10” = 10.

10. Clicking on the Order Mode tab will display the quantity pad in Order Mode.  By default the Limit button is selected. 
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Figure 7.  Navigator Quantity Pad - Order Mode

11. Limit – Clicking on the Limit button allows the trader to submit a Limit order.  The With a Tick (WAT) checkbox, Limit Threshold, Iceberg, Time in Force, and Order Type fields are enabled.
12. The WAT checkbox will enable the WAT Threshold (WT) field. A WAT order will move one tick in an effort to get filled if the quantity of the opposite side of the inside market falls below the specified WAT Threshold. If the Order Handling Mode is set to LTP Mode then the Last Traded Price must be at the opposite side of the inside market in order for the WAT order to move.
13. A WAT order will trigger only when it is on the inside market and the opposite side of the inside market is only one tick away.
14. If there is a gap in the inside market, and a WAT order is placed, the WAT order will wait for the gap to close. Once the gap closes, the WAT order will also wait for the depth at the opposite side of the inside market to first go above its threshold and then come back down below it before it triggers.
15. The Limit Threshold field allows the user to place a Virtual order, which is saved on the client machine until triggered, instead of a standard Limit order which is submitted to the exchange.  By default the Limit Threshold value is zero or blank which indicates that a standard Limit order will be placed.  If a Limit Threshold is entered, a Virtual order will be placed.  The Virtual order will be saved on the client machine until triggered by the appropriate Price and Quantity.
16. If LTP Mode is selected as the Order Handling Mode (from the Preference Menu), once the Last Traded Price equals the Limit Price AND the depth quantity at that Price is less than or equal to the specified Limit Threshold, the virtual order will be submitted into the market as a Limit order.
17. If Inside Market Mode is selected as the Order Handling Mode, for a Buy order once the Best Bid Price is less than or equal to the Limit Price AND the depth quantity at that Price is less than or equal to the specified Limit Threshold the virtual order will be submitted in the market as a Limit order.  For a Sell order once the Best Offer Price is greater than or equal to the Limit Price AND the depth quantity at that Price is less than or equal to the specified Limit Threshold the virtual order will be submitted in the market as a Limit order. 
18. The Time in Force field will allow the trader to designate for how long the order is valid.  The default selection is GTD: the order is valid only for the current trading session.  Selecting GTC indicates that the order is valid until the trader cancels the order or the contract expires. 
19. The Order Type field will allow the trader to designate if the order should be of type “Fill or Kill” (FOK), “Immediate or Cancel” (IOC), or “Market Limit Market” (MLM).  By default the Order Type will be <None> indicating it is not a “Fill or Kill”, “Immediate or Cancel”, nor “Market Limit Market” order. IMPORTANT: MLM orders are only available on the SFE gateways and will not show up for any other.
20. Market – Clicking on the Market button allows the trader to submit a Market order.  The Limit Threshold, Iceberg, Time in Force and Order Type fields are enabled and the cursor changes to a yellow arrow with the letters MRT.  
21. Clicking anywhere in the Bid columns will place a Buy Market Order.  Clicking anywhere in the Offer columns will place a Sell Market Order.
22. Stop – Clicking on the Stop button allows the trader to submit a Stop order.  The Stop Limit, Trailing Stop, Stop Threshold, Iceberg, and Time in Force fields are enabled.  The cursor changes to a yellow arrow with the letters STP.
23. The Stop Limit field determines if the order should be a Stop Limit or Stop Market order.  Checking the Stop Limit checkbox means that a Stop Limit is placed while leaving it unchecked means a Stop Market order will be placed.  By default the checkbox will not be checked indicating that a Stop Market order will be placed.
24. If the Stop Limit checkbox is checked, the Stop Limit Offset field becomes enabled.  The Stop Limit Offset field allows the trader to set the number of ticks the stop limit price is from the stop entry price.  
25. The Trailing Stop field allows the trader to designate that the stop order should trail with the market.  If LTP Mode is selected as the Order Handling Mode from the Preferences menu, the Trailing Offset equals the distance the stop was entered away from the last traded price and the stop will trail the LTP.  If Inside Market Mode is selected as the Order Handling Mode, for a Buy Stop the Trailing Offset equals the distance the stop was entered from the Best Offer and the Buy Stop will trail the Best Offer.  For a Sell Stop the Trailing Offset equals the distance the stop was entered from the Best Bid and the Sell Stop will trail the Best Bid.   
26. The Stop Threshold field, similar to the Limit Threshold field, allows the user to place a Virtual Stop, which is saved on the client machine until triggered, instead of a standard Stop order which is submitted to the exchange. 
27. If LTP Mode is selected as the Order Handling Mode (from the Preference Menu), once the Last Traded Price equals the Stop Price AND the depth quantity at that Price is less than or equal to the specified Stop Threshold, the virtual order will be submitted into the market as either a Market or Limit order.
28. If Inside Market Mode is selected as the Order Handling Mode, for a Buy Stop once the Best Offer Price is greater than or equal to the Stop Price AND the depth quantity at that Price is less than or equal to the specified Stop Threshold, the order will be submitted.  For a Sell Stop once the Best Bid Price is less than or equal to the Stop Price AND the depth quantity at that Price is less than or equal to the specified Stop Threshold, the order will be submitted.  If Stop Limit is not checked, a Market order will be placed.  If Stop Limit is checked, a Limit order will be placed based on the specified Stop Limit Offset.
29. If the contract being traded is on the SFE gateway, users will be allowed to select “Market Limit Market” (MLM) orders in the Order Type field.
30. OCO – Clicking on the OCO button allows the trader to submit a One-Cancels-Other (a.k.a. Order-Cancels-Order) order so that if one gets filled, the other will be canceled.  The Stop Limit, Trailing Stop, Limit Threshold, Stop Threshold, and Time in Force fields are enabled.  The cursor changes to a yellow arrow with the letters OCO.
31. An OCO can be either two stops, two limits, or the traditional stop and limit.  This pair of orders can be in just one contract or have an order in both contracts.  One or both of the orders can be set as Virtual orders by specifying a Limit and/or Stop Threshold.  If the OCO contains stops, as in Stop Mode, the Stop Limit field is used to designate if the order should be an OCO Stop Limit or OCO Stop Market order.  
32. If Detached Quantity Pad is selected from the Preferences menu a single panel of buttons displays.  The default version hides the fields for selecting the mode of the Quantity Pad amounts (Add, Calc, or Replace) as well as the additional fields for entering orders other then Limit orders.  The ellipses button can be clicked to view those additional fields.   
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Figure 8.  Navigator Quantity Pad – Detached 
Figure 9.  Navigator Quantity Pad – Detached(expanded)

33. The font size of the detached Quantity Pad can be increased or decreased independently of the Depth window.  To do so, select the Quantity Pad and press the “Shift + Left Arrow” of “Shift + Right Arrow” key combination, respectively.

Iceberg Orders

1.  Iceberg functionality is available for Limit, Market, and Stop orders.
2. There is a “QD” or “PD” (in the detached Quantity Pad) or “Iceberg QD” or “Iceberg PD” (in the attached Quantity Pad) text box where users can specify a Disclosed Quantity or Percentage. The text box that shows up will be determined by the “Iceberg Disclosure Mode” setting under the Preferences menu. When this text box is populated with a value, Navigator will iceberg orders. 

3. There are Iceberg Price Modes, Static and Last Fill, for choosing the price at which iceberg orders are submitted. Users will be able to specify which pricing method they would like to use with the “Iceberg Price Mode” setting under the Preferences menu, which has the following values:
· Static: Static pricing will submit all iceberg orders at the original order price. 

· Last Fill: Last Fill pricing will submit all iceberg orders at the last fill price.
4. Each leg of an Iceberg order may be split among different contracts if the user is in dual contract mode. Iceberg orders will always be colored blue to signify linked iceberg orders, similar to how linked OCO orders are colored. (Iceberg orders in single contract mode will also be colored blue to signify that it is part of an Iceberg). This coloring exists only within the Navigator application; it will not extend to X_TRADER or other XTAPI applications. In Figure 10, which shows the floating order pane in Navigator, the first two orders are part of the same iceberg cycle, which was split equally between the two contracts. When you hover over one order, both are highlighted to show the connection.
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Figure 10.  Navigator Order Pane      
5. In the floating order pane, users may view and change the total Iceberg Goal Quantity, as well as the individual order quantity and price.
6. In the depth window, Iceberg orders are colored blue to show a connection between orders submitted as part of the same Iceberg cycle.
7. If an Iceberg leg order is deleted or immediately rejected, all remaining quantity of the overall Iceberg order will be deleted as well. Simply, Iceberg functionality will stop when an Iceberg leg is deleted or immediately rejected.
8. Iceberg orders that are split between contracts will wait until both are fully filled before the next round is submitted.
9. If an Iceberg leg order is submitted in dual contract mode and is split between the two contracts due to routing rules and “Last Fill” Iceberg Price Mode is checked, when the user manually changes the price on any part of the iceberg order, the more aggressive price will be used.

· Example: “Last Fill” Iceberg Price Mode is checked. The ES Jun08 and ES Sep08 contracts are in a group, and a 20 lot buy at 114550 is submitted as part of an iceberg order, split evenly between the two contracts. If the 10 lot ES Jun 08 order is changed up two ticks to 114600, the next round of iceberg orders submitted will be at 114600, as this is the more aggressive price.
10. If the quantity of an Iceberg leg is changed the goal quantity will be changed correspondingly.

· Example: An iceberg order is working with a goal quantity of 100 and submitting 10 lot cycles. If one of the leg orders is changed from 10 to 5, the goal quantity will change to 95 to reflect the reduction.

11. When in “Percent” Iceberg Disclosure Mode, Navigator will use the percent value provided to find the order size for each round, with the last round possibly just being the remainder of what has not been submitted. For example, if a 10 lot Iceberg order is submitted with a Percent Disclosed of 25%, four separate orders with lot sizes 3, 3, 3, and 1 will be submitted. Since 10*(.25) = 2.5, each order size will round up to three. This leaves one remaining for the last round.
12. When entering Stop Iceberg Orders, only the first round will be submitted as a stop order. All subsequent rounds will be submitted as either a limit or market order depending on the original stop order type. This will allow users to have the first Iceberg order appear as a stop order, but will prevent the subsequent iceberg orders from being rejected for being submitted at an invalid price level.
Net Positions

1. The Net Positions will be duplicated on both the Buy side and the Sell side.  There will be the contract’s Net Position in the last row for Contract #1 & Contract #2.  These values will then be added together to provide the pair’s Net Position.  

2. Clicking on any of these values will seed the Quantity field with the absolute value of this value.  (i.e. Clicking on the -20 of WS in Figure 5 will seed the quantity field with 20).  If this value is greater than the Maximum quantity, it will seed the quantity with the Maximum quantity. 

Entering Orders

1. When the user clicks on the blue column in the Depth window they will be sending in a Buy order.  When the user clicks on the red column in the Depth window they will be sending in a Sell order.

2. Clicking in either of the Contract columns will enter an order for that contract without applying any rules.  Clicking on a cell in the blue combined bid column will enter a Buy order in the contract that meets the order routing criterion specified in the Setup window.  The same rules apply for entering Sell orders with the Red column.          

3. By default (if the Order Mode has not been changed using the quantity pad) orders submitted through the Depth window will be GTD Limit orders at the Limit price corresponding with the price of the row that was selected.

4. For stop orders, the Stop Price submitted corresponds to the price of the row that was selected and the Stop Limit Price is based on the stop price and the stop limit offset.

5. The cursor will change to yellow along with the letters MRT, STP or OCO if the user has designated that a Market, Stop, or OCO order should be placed.  While entering an OCO order after selecting the first price, the cursor will change to pink.  After the second price is selected, the cursor will change back to yellow.  

6. For OCO orders, when a partial fill comes in on either of the two orders, the other order will be reduced by the amount that was partially filled.  When one order is deleted, the paired order is also deleted.

Working Orders

1. By default both working Buy and Sell orders are displayed on the left hand side of the Depth window.  If both a Buy order and a Sell order are resting at the same price, the working orders column will display an “x” between the buy quantity and the sell quantity (i.e., 25 x 25).

2. When the “Split Buy/Sell Order” is selected, working Buy orders display in the left column while working Sell orders display in the right column.

3. All orders for both contracts at one price level will be totaled up, and just the overall total quantity at that price level will be displayed.

4. Right clicking on any order and dragging it to another price level will adjust that order, changing its Limit Price. 

5. Pressing “Shift + Right Click” or “Ctrl + Right Click” on any order will reapply the route to best rules.  This may mean if it was joining before it may now be lifting.

6. Left clicking on the order will delete all orders across both contracts at that price level.
7. Left clicking in the total orders field will delete all orders for that pair using “Smart Delete” functionality.  The sequence in which the orders are deleted is based on their position in the market.  Orders closer to the market price will be deleted before those which are farther away.  This minimizes the chance of getting filled in a fast market before all of the deletes can be processed.
8. Hovering over one order of an OCO order will highlight it yellow along with its corresponding order.  If the corresponding order is not currently viewable in the Depth window, the order will instead be highlighted in orange.

9. Virtual Orders have a beige background. 

Order Pane
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  Figure 11.  Navigator Order Pane
1. The Order Pane, when displayed, shows details about the orders that are working.  Figure 11 displays an example Order Pane which contains all orders for a given group.

2. From the Preferences menu the user can choose from five different settings to display or hide the Order Pane: No Delay, ½ Sec. Delay, 1 Sec. Delay, Center Click Active, and Hide Order Pane. The “No Delay” option displays the order pane immediately after hovering over any working order(s) in the Depth Window. The “½ Sec. Delay” and “1 Sec. Delay” options display the order pane after a short delay.  The “Center Click Active” option will display the order pane when the center mouse button is clicked on a working order in the Depth Window, clicking anywhere else will re-center the grid. The order pane will stay hidden when the “Hide Order Pane” option is selected.

3.  To change the order Quantity, Price(s), Trailing Offset, Limit Threshold, and/or Stop Threshold left click or right click the column to decrease or increase the value, respectively.  To commit the change(s) click on the “OK” value in the Chg column. A light gray background on an item indicates that this value can be changed.  If you change a value and leave the window without confirming “OK”, the changes will be lost.  

4. To delete an order, click the “X” value in the Del column.

5. The Stop Price, Trailing Offset, Limit Threshold, and Stop Threshold columns will only display if they are applicable to the working orders.  
6. Orders are highlighted in yellow to indicate that they are part of an OCO order.

7. Orders with a Time Stamp of “Not In Market” are Virtual orders, saved on the client machine.

Order Confirmation window

1. If the Add Order Confirmation preference is checked on the Global Settings menu, a message window will display before any order is placed.  See Figure 12 below for an example of the Order Confirmation window for a Stop Limit Order with a Threshold.

2. If the Route to Best column triggered the message for confirmation, if the value has two (2) contracts, then the confirmation will be ignored.

3. If the user changes the Order Quantity to a value which exceeds the Max Quantity, upon leaving the cell the Max Quantity is entered.
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           Figure 12.  Order Confirmation window

4. Some values for the order can be changed on the Order Confirmation window.  The Customer can be changed by selecting a different Customer in the dropdown.  A different Account Number, Quantity, Stop Limit Offset, or Threshold can be entered by selecting the cell with the previous value and typing a new one.  A Buy order can be changed to a Sell order or a Sell order can be changed to a Buy order by selecting the Buy or Sell value.  The Price can be changed by selecting the previous price and left-clicking to reduce the price or right-clicking to increase the price.  Trailing can be turned on and off for a Stop order by selecting the Trailing Active checkbox.  The Exchange, Contract, and Order Type values cannot be changed.  Only the fields applicable for the placed order will display in the Confirmation window.  For example, the Stop Limit Offset, Trailing Active, and Threshold values would not display when placing a standard Limit order.

5. Selecting the Confirm button will place the order while selecting the Cancel button will not submit the order.
6. If the Delete Order Confirmation preference is selected, a basic message window will display confirming if you want to Delete your order.  

7. If the Change Order Confirmation preference is selected, a basic message window will display confirming if you want to Change your order.

Locally Held Orders

1. If Navigator is closed while Virtual Orders are working, a message will display.  If the user confirms that Navigator should close, the Virtual Orders will be saved.  Upon re-launching Navigator, the orders will be in a locally held state and can then either be released as virtual orders or deleted.  Locally held orders are distinguished by a peach background.  Figure 13 displays the Order Pane with a locally held order.
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                Figure 13.  Order Pane – Locally Held Order

2. In order to release a locally held order back into a Virtual order, click on Send in the Rel column of the Order Pane.  The order will change from a peach background to a beige background and the Time Stamp column will display Not In Market to indicate the order is again a Virtual Order.   

3. In order to instead delete the locally held Order, click the X in the Del column of the Order Pane.  

Navigator – Depth Window (Combined View)
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Figure 14.  Navigator – Depth window (Combined View)

1. The Combined depth window is accessed by right clicking anywhere on the window and selecting Combined View from the pop-up menu. 

2. The Combined depth window is the same as the View All depth window except the four columns containing the contract information is hidden.

Navigator – Depth Window (Split View)
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Figure 15.  Navigator – Depth window (Split View)

1. The Split depth window is accessed by right clicking anywhere on the depth window and selecting Split View from the pop-up menu. 

2. The Split depth window is the same as the View All depth window except the two columns summing up the combined quantities at each price level are hidden.  This means the user cannot enter route to best logic.

Navigator – Depth Window (View All)
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                       Figure 16.  Contract with different tick values

1. The power of the Navigator becomes apparent when one contract is more granular than the other. (ex. WS trades in .01, QM trades in .025).  Prices at better levels can be displayed and traded against.

2. Users can trade at the non-tradable prices, but that will be rounded to the next tradable price away from the market.

Display Price Columns
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              Figure 17.  Display Price Columns Mode

1. The Display Price Columns view is accessed by right clicking anywhere on the depth window and selecting Display Price Columns from the pop-up menu.  All views (Combined, Split, and View All) can utilize the display price columns mode. 

2. The inside column that is closest to the actual prices is Contract #1. The outside column is Contract #2. 

3. This mode can be used to assist the user in lining up the two contract’s prices.   Each column will display the actual price at that level after that contract’s price has been modified for a Price Multiplier and/or Offset in the Setup Window.
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Figure 18. Exchange Unavailable

1. In the event that one of the exchanges is unavailable, the Depth window will display that exchange’s bid and ask columns in gray.  The available contract’s and combined contracts’ order depth columns change to pastel blue and red.  When the user clicks in the combined column, Navigator will determine if order should be placed in the available contract based on the Exchange Unavailable Preference setting.  See #20 of the Navigator – Menu Options section.
Navigator – Grid Window
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      Figure 19.  Navigator – Grid window

1. There is only one Grid window that is launched from the Navigator – Main window.  This window contains all the pairs listed out as a row.   

2. Clicking on a column that starts with a ‘#’ will seed with that particular contract.  When the Buy or Sell is pressed, it will submit an order just for that contract without using the rules.

3. Clicking on any other column that does not start with a ‘#’ will seed with the pair name.  When the Buy or Sell is pressed, it will use the rules to route to the best market.

Single Contract Mode
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 Figure 20.  Main for Single Contract

1. Navigator can support having only a single Contract for a Navigator line item (see Figure 20).
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    Figure 21.  Setup for Single Contract

2. Many of the fields are removed if a Single Contract is entered because those fields pertain to either the second contract or how the first contract interacts with the second contract. 

3. The Price Layout information in the Layout tab is not enabled. All other information can be configured exactly the same for single contract mode or for two contracts.
4. By default, when depth is opened for a row with a single contract, it will be opened in Combined View.

5. If Confirmations are turned on, and an order is entered in Combined View the confirmations will still be prompted. 

Requirements

This application requires:

· X_TRADER® API 
· X_TRADER® Pro 

Examples

All of the following examples refer to the following image.
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Lifting

Optimize (Ignore Position) 

	Contract #1 %
	Contract #2 %
	Buy / Sell
	Quantity
	Price
	Contract #1 Quantity 
	Contract #2

Quantity 

	100%
	0%
	Buy
	5
	111195
	0
	5

	100%
	0%
	Buy
	100
	111195
	0
	100

	100%
	0%
	Buy
	1,000
	111195
	418
	582

	100%
	0%
	Buy
	2,000
	111200
	583
	1417

	100%
	0%
	Buy
	3,000
	111205
	1099
	1901

	50%
	50%
	Buy
	5
	111195
	0
	5

	50%
	50%
	Buy
	100
	111195
	0
	100

	50%
	50%
	Buy
	1,000
	111195
	209
	791

	50%
	50%
	Buy
	2,000
	111200
	583
	1417

	50%
	50%
	Buy
	3,000
	111205
	960
	2040


	Contract #1 %
	Contract #2 %
	Buy / Sell
	Quantity
	Price
	Contract #1 Quantity
	Contract #2

Quantity

	100%
	0%
	Sell
	5
	111190
	5
	0

	100%
	0%
	Sell
	100
	111190
	100
	0

	100%
	0%
	Sell
	1,000
	111190
	237
	763

	100%
	0%
	Sell
	2,000
	111185
	796
	1204

	100%
	0%
	Sell
	3,000
	111180
	870
	2130

	50%
	50%
	Sell
	5
	111190
	3
	2

	50%
	50%
	Sell
	100
	111190
	50
	50

	50%
	50%
	Sell
	1,000
	111190
	237
	763

	50%
	50%
	Sell
	2,000
	111185
	602
	1398

	50%
	50%
	Sell
	3,000
	111180
	833
	2167


Optimize (Flatten Position First) 
Contract #1 = Short -45
Contract #2 = Long 65

	Contract #1 %
	Contract #2 %
	Buy / Sell
	Quantity
	Price
	Contract #1 Quantity
	Contract #2

Quantity

	100%
	0%
	Buy
	5
	111195
	0
	5

	100%
	0%
	Buy
	100
	111195
	0
	100

	100%
	0%
	Buy
	1,000
	111195
	418
	582

	100%
	0%
	Buy
	2,000
	111200
	583
	1417

	100%
	0%
	Buy
	3,000
	111205
	1099
	1901

	50%
	50%
	Buy
	5
	111195
	0
	5

	50%
	50%
	Buy
	100
	111195
	0
	100

	50%
	50%
	Buy
	1,000
	111195
	209
	791

	50%
	50%
	Buy
	2,000
	111200
	583
	1417

	50%
	50%
	Buy
	3,000
	111205
	960
	2040


Contract #1 = Short -45
Contract #2 = Long 65

	Contract #1 %
	Contract #2 %
	Buy / Sell
	Quantity
	Price
	Contract #1 Quantity
	Contract #2

Quantity

	100%
	0%
	Sell
	5
	111190
	0
	5

	100%
	0%
	Sell
	100
	111190
	35
	65

	100%
	0%
	Sell
	1,000
	111190
	237
	763

	100%
	0%
	Sell
	2,000
	111185
	796
	1204

	100%
	0%
	Sell
	3,000
	111180
	870
	2130

	50%
	50%
	Sell
	5
	111190
	0
	5

	50%
	50%
	Sell
	100
	111190
	18
	82

	50%
	50%
	Sell
	1,000
	111190
	237
	763

	50%
	50%
	Sell
	2,000
	111185
	602
	1398

	50%
	50%
	Sell
	3,000
	111180
	833
	2167


Constant percentages 

	Contract #1 %
	Contract #2 %
	Buy / Sell
	Quantity
	Price
	Contract #1 Quantity
	Contract #2

Quantity

	100%
	0%
	Buy
	5
	111195
	5
	0

	100%
	0%
	Buy
	100        
	111195
	100
	0

	100%
	0%
	Buy
	1,000
	111195
	1,000
	0

	100%
	0%
	Buy
	2,000
	111200
	2,000
	0

	100%
	0%
	Buy
	3,000
	111205
	3,000
	0

	50%
	50%
	Buy
	5
	111195
	3
	2

	50%
	50%
	Buy
	100
	111195
	50
	50

	50%
	50%
	Buy
	1,000
	111195
	500
	500

	50%
	50%
	Buy
	2,000
	111200
	1,000
	1,000

	50%
	50%
	Buy
	3,000
	111205
	1,500
	1,500


	Contract #1 %
	Contract #2 %
	Buy / Sell
	Quantity
	Price
	Contract #1 Quantity
	Contract #2

Quantity

	100%
	0%
	Sell
	5
	111190
	5
	0

	100%
	0%
	Sell
	100        
	111190
	100
	0

	100%
	0%
	Sell
	1,000
	111190
	1,000
	0

	100%
	0%
	Sell
	2,000
	111185
	2,000
	0

	100%
	0%
	Sell
	3,000
	111180
	3,000
	0

	50%
	50%
	Sell
	5
	111190
	3
	2

	50%
	50%
	Sell
	100
	111190
	50
	50

	50%
	50%
	Sell
	1,000
	111190
	500
	500

	50%
	50%
	Sell
	2,000
	111185
	1,000
	1,000

	50%
	50%
	Sell
	3,000
	111180
	1,500
	1,500


Joining

	Contract #1 %
	Contract #2 %
	Buy / Sell
	Quantity
	Price
	Contract #1 Quantity
	Contract #2

Quantity

	100%
	0%
	Buy
	5
	111190
	5
	0

	100%
	0%
	Buy
	100
	111190
	100
	0

	100%
	0%
	Buy
	1,000
	111190
	1,000
	0

	100%
	0%
	Buy
	2,000
	111185
	2,000
	0

	100%
	0%
	Buy
	3,000
	111185
	3,000
	0

	50%
	50%
	Buy
	5
	111190
	3
	2

	50%
	50%
	Buy
	100
	111190
	50
	50

	50%
	50%
	Buy
	1,000
	111190
	500
	500

	50%
	50%
	Buy
	2,000
	111185
	1,000
	1,000

	50%
	50%
	Buy
	3,000
	111185
	1,500
	1,500


	Contract #1 %
	Contract #2 %
	Buy / Sell
	Quantity
	Price
	Contract #1 Quantity
	Contract #2

Quantity

	100%
	0%
	Sell
	5
	111195
	5
	0

	100%
	0%
	Sell
	100
	111195
	100
	0

	100%
	0%
	Sell
	1,000
	111195
	1,000
	0

	100%
	0%
	Sell
	2,000
	111200
	2,000
	0

	100%
	0%
	Sell
	3,000
	111205
	3,000
	0

	50%
	50%
	Sell
	5
	111195
	3
	2

	50%
	50%
	Sell
	100
	111195
	50
	50

	50%
	50%
	Sell
	1,000
	111195
	500
	500

	50%
	50%
	Sell
	2,000
	111200
	1,000
	1,000

	50%
	50%
	Sell
	3,000
	111205
	1,500
	1,500


Quantity








Right-Click Quantity





Total Working Orders





Last Traded Price





Net Position Contract #1





Net Position Contract #2





Net Position Combined





Alias Name





Working Sell Order





Working Buy Orders





Customer Profile #2





Last Order Placed





Customer Profile #1
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